Chapter 3

Working with
Basic Tools and
Coordinate Systems

After completing this chapter, you will be able to:
* Use basic tools for mapping

* Use coordinate systems

* Modify the settings and alignment of the UCS triad

* Create and modify coordinate systems

* Assign coordinate system to drawings and datasets
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INTRODUCTION

In this chapter, you will learn some of the basic navigation and productivity enhancement tools
such as Zoom, Pan, and Snap which will be frequently used while creating and analyzing the
drawing data. These tools provide a flexible viewing and editing environment thereby enhancing
the productivity and accuracy of the spatial database.

In this chapter, you will learn to perform various operations such as zooming, panning, and
scaling the drawings. In Map 3D, while creating drawing objects, you will also learn to use the
Ortho mode and the snap options.

Further in this chapter, you will learn about the User Coordinate System (UCS) and the World
Coordinate System (WCS) in AutoCAD Map 3D. Also, the coordinate system for referencing
drawing objects to the real world will be discussed in this chapter.

USING THE BASIC NAVIGATION TOOLS

The mapping procedures such as editing and reviewing data, frequently requires the drawing
data to be scaled, zoomed, and panned. These operations require the use of the Pan and Zoom
tools, which makes them the most extensively used tools in AutoCAD Map 3D. Some of these
frequently used navigation tools are discussed next.

Zoom Tools

Command: ZOOM or Z

. . . . Extents
In GIS, sometimes you may need to check the minute spatial details of the .

data displayed, and alter it, if required. For carrying out such tasks, using -

. . . . 9 Window
an enlarged view of the objects in the drawing area would be advantageous.
The zoom tools are used to enlarge or reduce the view of a drawing without

affecting the actual size of the drawing objects. You can use various zoom o, Previous
tools such as Extents, Realtime, Window, Previous, Object, and All to @

view a particular area of the drawing in an enlarged view/window. Acaltime
To use different zoom tools in the drawing process, click on the down-arrow '.\ Al
next to the Extents tool in the Navigate panel of the View tab; all the ra

zoom tools will be displayed in a drop-down. Figure 3-1 shows the zoom » @ Dynamic
tools available in the drop-down. Choose the required zoom tool from the =
drop-down to proceed. Some of the important zoom tools are discussed Ly SR

next.

w
LR
“a Center
b

'.\ 0 h_| ect

Extents

W The Extents tool is used to display all the objects in the drawing
88 within the extent of the current drawing window. To display all the
drawing objects within the drawing, choose the Extents tool in the Navigate
panel from the View tab; the selected data will get enlarged.

Figure 3-1 Various
zooming tools
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Q Tip: You can use the Zoom to Extents option to display all the data within the required feature
layer. To do so, right-click on the required layer in the TASK PANE; a shortcut menu will be
displayed. Choose the Zoom to Extents option from the displayed menu; the drawing will zoom

to display all the data within the extent of the selected layer.

Window
You can zoom in a region of a drawing by drawing a window around the area to be zoomed.
= To do so, choose the Window tool from View > Navigate > Extents drop-down; you will
be prompted to specify the first corner of the area to be zoomed. Click in the drawing; you will
be prompted to specify the opposite corner. Specify the other corner. You can also specify the
two corner points of the rectangular area by entering the coordinates in the Command prompt.
On specifying the area, the center of the specified area (window) will become the center of the
new display screen. When you use this zoom tool, the area inside the window gets magnified
and fills the drawing window.

Previous

o While working on a complex drawing, you may need to zoom in on a portion of the drawing
W (0 edit some minute details of the drawing object. After you have completed the editing,
you may want to return to the previous view. This can be done by using the Previous tool.
AutoCAD remembers the last ten views, and these views can be restored by using the Previous

tool.

Realtime

You can use the Realtime tool to zoom in and zoom out a drawing interactively
by using the left mouse button. To do so, choose the Realtime tool from View > Navigate >

Extents drop-down; the Realtime tool will be invoked. Next, press and hold the left mouse

button and then drag the cursor up or down to zoom in or zoom out the drawing. To exit the

Realtime zooming mode, right-click in the drawing window; a shortcut menu will be displayed.

Choose the Exit option from this menu. You can also press ESC or ENTER to exit the mode.

Q Tip: You can also use the scroll wheel to zoom i or out of the drawing.

All

This tool is used to zoom to the drawing limits or the extents of the objects in the drawing

window, whichever is greater. Whenever you increase the limits, the current display is not
affected and hence it is not displayed. In this case, you need to use the All tool to display the
limits of the drawing. Sometimes it is possible that the objects are drawn beyond the limits. In
such a case, the All tool zooms to fill the drawn objects in the drawing area, irrespective of their
limits.

Scale
This tool is commonly used while plotting a drawing. This tool allows you to zoom into
bl the drawing using the specified scale. To zoom a drawing using this option, choose the
Scale tool from View > Navigate > Extents drop-down; you will be prompted to specify the
scale factor. Enter the scale factor and then press ENTER; the drawing will be zoomed to the
specified scale.
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Center
X278 This tool is used to increase or decrease the magnification of the view in the current
“ e

s viewport. To zoom in or zoom out from the view using this option, choose the Center tool
from View > Navigate > Extents drop-down; you will be prompted to specify the center. Click
in the drawing to specify the center point; you will be prompted to specify the magnification or
height. Specify the magnification and press ENTER; the drawing will zoom to the area with the
specified point at its center and at the given magnification.

Object
You can use the Object tool from the Extents drop-down to zoom to the selected object/s.
I When you choose the Object tool, you will be prompted to select the object/s. By using
the selection box or clicking on the individual object/s, you can select the required objects in
the current drawing. After selecting the objects, press ENTER; the drawing window will zoom
to the selected objects.

Pan Tool

Ribbon: View > Navigate > Pan
Command: PAN

3§ Pan You can use the Pan tool to pan a drawing interactively. This means you can shift a

drawing by sliding it, and then placing it at the required position. To slide a drawing,
choose the Pan tool from the Navigate panel; the cursor will change into a hand symbol,
indicating that you are in the pan mode. Place the cursor in the drawing area and then press
and hold the left mouse button. Now, you can drag the cursor to the required place on the screen
to move the drawing. To exit the pan mode, right-click in the drawing; a shortcut menu will be
displayed. Next, choose the Exit option from displayed menu. You can also press the ESC or
ENTER key to exit the pan mode.

AutoCAD Map 3D Scale
Status Bar: AutoCAD Map 3D Scale

The AutoCAD Map 3D Scale tool in the Status
Bar is used to set the scale of a layer or a view.
If you change this scale, the zoom level of the =
drawing will also get changed. To zoom using 1:1.063%6 ~ &
the AutoCAD Map 3D Scale tool, click on the '
down arrow in the Status Bar displayed on the ~ Figure 3-2 The AutoCAD Map 3D Scale tool with
right of the AutoCAD Map 3D Scale tool; a  the pop-up menu displayed and the Custom option
pop-up menu will be displayed, as shown in chosen

Figure 3-2. Choose the Custom option from the pop-up menu; the scale editing window will be
displayed. In this window, you can specity the scale of the drawing viewport. To do so, enter the
required value in the Enter scale value edit box. Next, choose the OK button in this window;
the drawing will be displayed at the modified scale value.

Infinity

Cugtom...
h

If you increase the scale value by using the AutoCAD Map 3D Scale tool, the size of the drawing
view will be reduced in the drawing window, as shown in Figure 3-3. If you decrease the scale
value by using this tool, the size of the drawing view in the drawing window will be magnified.
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Figure 3-3 The drawing views at different scale values

Note
@ 1. If a drawing view is altered by using a Zoom tool, the scale value in the AutoCAD Map 3D
~ Scale tool will also be altered accordingly.

2. Any modification made in a drawing view by using the AutoCAD Map 3D Scale or Zoom
tool will not affect the physical measurements of the drawing.

USING THE SNAP FUNCTIONS IN MAP 3D

In AutoCAD Map 3D, you can snap the cursor or snap to a desired point in an object using the
snap functions. If you activate the snap function while in the drawing mode, you can track some of
the known object points, vertices, or nodes in the drawing. AutoCAD Map 3D provides two basic
types of snap functionalities, grid snap and object snap. These snap functions are discussed next.

Snapping Cursor (Using Snap Spacing)

The Snap Mode button from the Status Bar is used to activate the function that allows the m
user to snap to the points using specified snap spacing. You can specify the parameters

for snapping using the options in the Snap and Grid tab of the Drafting Settings dialog box.

To invoke the Drafting Settings dialog box, click on the down-arrow next to the Snap Mode
button; a menu will be displayed. Choose the Snap Settings option; the Drafting Settings dialog
box will be displayed, as shown in Figure 3-4. The method of setting the properties in the Snap
and Grid tab of this dialog box is discussed next.

Note
Choosing the Grid Mode button from the Status Bar will result in the display of the grid i
along the XY plane in the drawing window.
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|& Drafting Settings @
Snap and Grid | Palar Tracking | Object Snap | 30 Object Snap | Dynamic Input | Quig| 1 | *
7] Snap On (F9) Grid On {F7)

Snap spacing (Grid style

Snap X spacing: 0.5000 Digplay dotted grid in:
[7] 2D mode! space

Snap Y spacing: 0.5000 [ Block editor

Sheetlayout

Equal X and Y spacing [ Sheetayo
Grid spacing

Polar spacing Grid ¥ spacing: 0.5000

Polar distance: 0.0000 Grid ' spacing: 0.5000
Major line every: 5 =

Snap type

@ Grid snap Grid behavior
. Adaptive grid
@ Rect I
i Felsnauiarsnap [] Allow subdivision below grid
() lsometric snap spacing
) Display grid beyond Limits
) PolarSnap 7] Follow Dynamic UCS

[oC [ Coen ][0

Figure 3-4 The Drafting Settings dialog box with the Snap and Grid tab chosen

Snap and Grid Tab

Choose the Snap and Grid tab in the Drafting Settings dialog box to display various options.
The Snap On (F9) check box in this tab is clear by default, which allows the cursor to move freely
in the drawing window. Selecting the Snap On (F9) check box will activate the Snap Mode. As a
result, the cursor will snap to the points at the specified snap spacing. The Grid On (F7) check
box is also clear by default in this tab. Therefore, the grid pattern will not be displayed. You
can select the Grid On (F7) check box to display the grid pattern in the drawing window. The
different areas in this tab are discussed next.

g Tip: You can display the grid lines in any 2D drawing space by choosing the Grid Mode button
\ i the Status Bar. Similarly, you can invoke the snapping mode by choosing the Snap Mode
button in the Status Ba:

Grid style Area

The options in the Grid style area are used to specify the display style of the dotted grid
pattern in the 2D model space, block editor, or the sheet or layout modeling space. You can
select the 2D model space check box to display the dotted grid pattern in the 2D drawing
environment. Similarly, you can select the Block editor check box to display the dotted grid
pattern while editing blocks.
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Grid spacing Area

The options in the Grid spacing area are used to adjust the spacing between grid points
along the X and Y axes. To modify the spacing between grid points along the X axis,
enter the required value in the Grid X spacing edit box. Similarly, to modify the spacing
between grid points along the Y axis, enter the required value in the Grid Y spacing edit
box. To modify the number of minor lines between two major lines while working in the
3D sketching mode, enter a value in the Major line every edit box or set the value using
the spinner located next to it.

Grid behavior Area

The options in the Grid behavior area are used to modify the settings for the grid display.
The Adaptive grid check box in this area is selected by default. As a result, the number of
grid lines or grid line density between the major grid lines will be limited during zoom out.
Select the Allow subdivision below grid spacing check box in the Adaptive grid option in
the Grid Behaviour Area if you want to display subdivision lines in the minor grid lines,
while zooming in the drawing. To display grids beyond the limits of window, select the
Display grid beyond Limits check box. To attach the grid plane to the current UCS, select
the Follow Dynamic UCS check box.

Snap spacing Area

The options in the Snap spacing area are used to set the snap spacing in the grid mode. To
modify the snapping distance between two snap points along the X-axis, enter the required
value in the Snap X spacing edit box. Similarly, to set the snapping distance between two
snap points along the Y-axis, enter the required value in the Snap Y spacing edit box. To set
different snapping spaces between snap points along the X and Y axes, clear the Equal X
and Y spacing check box. Various methods to customize the snap spacing are discussed next.

Snap to Grid: In the snap to grid mode, if you move the cursor in the XY-plane, the cursor
will snap to the adjacent grid point, refer to (1) in Figure 3-5.

: 7Grid Points

C Grid X spacing
) ﬁ ﬁ @ {}D J

4y
FGrid Y spacing

TN

Figure 3-5 Different grid snapping options with grid details
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Snap to Spacing: In the snap to spacing mode, if you modify the snap spacing without
changing the grid spacing, the cursor will snap to the point located at the modified snap
spacing, refer to (2) in Figure 3-5.

Snap to Unequal X Spacing and Y Spacing: In the snap to unequal X spacing and Y
spacing, if the snap spacing in the X axis and the Y axis are different, then the cursor will
trace the next grid point with the corresponding snap spacing given in the X and Y axes,
refer to (3) in Figure 3-5.

Snap type

The options in the Snap type area are used to specify the snap type. To snap the cursor to
grid points in the X and Y axes, select the Grid snap radio button. In the grid snap mode,
you can choose option depending on your drawing requirement. To draw a geometric
model in the rectangular snap mode, select the Rectangular snap radio button. To draw
a geometric model in the isometric snap mode, select the Isometric snap radio button.
While working in the Polar Tracking mode, you can set the cursor to snap along the polar
alignment angles by selecting the PolarSnap radio button.

Object Snap

The object snapping helps the users to snap to the precise locations on objects. You can activate
object snapping by pressing the F3 function key. AutoCAD Map 3D identifies various locations
such as end point, midpoint, center, node and intersection as snap locations. You can choose
the required snap modes from the Object Snap tab of the Drafting Settings dialog box. The
various options in the Object Snap tab are discussed next.

Object Snap Tab

The options in the Object Snap tab are used to snap to geometric points on a drawing object. In
this tab, the Object Snap On (F3) and Object Snap Tracking On (F11) check box are selected
by default. Additionally, you can toggle the object snap and object snap tracking on or oft. The
options in the Object Snap modes area are used to control the object snap tracking types. Some
of the frequently used object snap tracking options are discussed next.

Q Tip: You can also twrn on an object snap option by right-clicking on the Object Snap '=I':|
button in the Status Bar, and then choosing the required snapping option from the
shortcut menu displayed.

Endpoint
The Endpoint object snap tracking Crosshair
option is used to draw an object with E”dpo'm——"%_/
reference to an endpoint of another drawing [Endbsint }— Object snap type

object. If you select the Endpoint check box,
the crosshair will trace the endpoint of the
drawing object in the drawing mode. The
endpoint object snapping is illustrated in
Figure 3-6.

Figure 3-6 The Endpoint object snapping
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Figure 3-7 The Midpoint object snapping

Midpoint

M The Midpoint object snap option is used to draw an object with reference to the middle
point of a line drawing. If you select the Midpoint check box, the crosshair will snap

to the middle point of a nearby line drawing. The midpoint object snapping is illustrated

in Figure 3-7.

Center

I:::I The Center object snap option is used to track the center of a circle, arc, ellipse, or
elliptical arc and then draw objects with reference to the center. To use this option in

the drawing, select the Center check box. Figure 3-8 shows an example of the center object

snapping.

Tangent

The Tangent object snap option is used to track a tangent point along an arc and a
[s] circular geometry. To invoke this option, select the Tangent check box. The tangent
object snapping is illustrated in Figure 3-9.

Quadrant

{:} The Quadrant object snap option is used to create a drawing with respect to one of
the four quadrant points. To invoke this option, select the Quadrant check box.

Figure 3-10 illustrates an example of using the Quadrant object snapping option.

Midpoint snap indicator Crosshair

Center snap indicator
Crosshair

Object snap type

Obiject snap type

Figure 3-8 The Center object snapping

Quadrant
Point 2

Quadrant Quadrant
Tangent snap indicator Point 3 Point 1
1 | I
Crosshair Quadrant snap type
Crosshair
Object snap type [Quadant |
ian B
Quagrant -Oblect snap ype
Point 4
Figure 3-9 The Tangent object snapping Figure 3-10 The Quadrant object snap located

at the first quadrant

Node
o The Node option is used to snap to a point object in the drawing mode. To apply the
node object snapping to the drawing mode, select the Node check box. You can draw
an object from the point object by using this option. An example of drawn line using three
point (nodes) is shown in Figure 3-11.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 3-11 The node object snapping

Note

The other object snap options such as Intersection, Extension, Insertion, Perpendicular,
Nearest, Apparent intersection, and Parallel are used to snap crosshair at different points
along the drawing objects in the drawing mode.

WORKING IN THE ORTHO MODE

L You can turn the Ortho mode on or off by choosing the Ortho Mode button in the Status

Bar or by using the F8 key. The Ortho mode allows you to draw lines at right angles in 2D
drawings only. Whenever you use the pointing device to specify the next point, the movement
of the rubber-band line connected to the cursor will be either in the horizontal (parallel to the
X axis) or vertical (parallel to the Y axis) direction. To draw a line in the Ortho mode, specify
the starting point at the Specify first point prompt. To specify the second point, move the cursor
with the pointing device and click at the desired point. The line thus drawn will be either vertical
or horizontal, depending on the direction of movement of the cursor, refer to Figures 3-12
and 3-13.

®

First Point \
First Point \

/—Second Point

=

/Second Paint

ped

Figure 3-12 Drawing a horizontal line using Figure 3-13 Drawing a vertical line using
the Ortho mode the Ortho mode
Note

You can turn Ortho mode on and off at any time during drawing and editing. But in 3D views,
Ortho mode restricts the cursor movement in up and down divections.
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COORDINATE REFERENCE SYSTEM (CRS)

A coordinate reference system (CRS) defines how an object relates spatially to the locations on
the Earth’s surface. CRS is a mathematical model used to locate geographical entities. Using a
coordinate reference system, you can integrate multiple datasets with different CRS into your
project. In AutoCAD Map 3D, there are two coordinate system: a fixed reference system called
world coordinate system (WCS) and a user defined coordinate system called user coordinate
system (UCS). CRS is referred to as coordinate system or global coordinate system. Assigning
appropriate coordinate system is the most essential part of the data preparatory work.

A CRS associates a coordinate system with an object by means of a datum. As a result, the definition
of a CRS must encompass the definition of a coordinate system and a datum. Everest 1830, NAD
83 and WGS 84 are some of the commonly used datum.

A geographic data can be represented using the Geographic Coordinate System and the Projected
Coordinate System. A Geographic Coordinate System is defined as a 3D surface model and
measured in latitudes and longitudes. A Projected Coordinate System is a model that is defined
by a flat 2D surface and can be measured in meters and feet. Coordinate systems provide a
framework for defining real world locations.

The Prime Meridian located at the Royal Observatory,
Greenwich is used as a reference point for measuring
Longitudes or East/West angles. Longitude (A) of a point is
defined as the angle from the prime meridian to the meridian
plane of a given point while latitude (@) is the angle between
the equatorial plane and the perpendicular to the ellipsoid
through a given point. Figure 3-14 shows the latitude and
longitude of point P.

Next, you will learn to define a new coordinate reference Figure 3-14 Latitude and Longitude
system using the Create tool in AutoCAD Map 3D. of point P

Creating a Coordinate Reference System

Ribbon: Map Setup > Coordinate System > Create drop-down >
Create Coordinate System
Command: MAPCSCREATE

You can define a new datum, ellipsoid, or a coordinate system using the Create Coordinate
System tool in the Coordinate System panel of the Map Setup tab. The new coordinate system
can be created by modifying an existing coordinate system or by defining the parameters for
the coordinate system.

, Note

@ 1t is recommended that a user must know thoroughly the concepts of the tervestrial and celestial
reference systems or map projections. If you do not have sufficient knowledge and accurate defining
parameters, avoid defining a new global coordinate system.

t www.cadcim.com
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AutoCAD Map 3D saves all the defined coordinate reference systems in a single folder. You will
require a written permission to save the created CRS in this folder. Follow the steps given next
to change the permission for this folder.

1. Close the AutoCAD Map 3D 2016 software application, if it is running.
2. In the Windows Explorer, browse to the following folder location:
C:\ProgramData\Autodesk

3. In the Autodesk folder, right-click on the Geospatial Coordinate Systems <version>
folder; a menu will be displayed. In the menu, choose the Properties option; the Geospatial
Coordinate Systems <version> Properties dialog box will be displayed.

4. In this dialog box, choose the Security tab; the options in this tab will be displayed. Choose
the Edit button in this tab; the Permissions for Geospatial Coordinate Systems <version>
dialog box will be displayed.

5. In this dialog box, select a user name from the Group or user names list box; the permissions
assigned to the selected user will be displayed in the Permissions for <Users> list box.

6. In the Permissions for <Users> list box, select the check box corresponding to the Full
Control option in the Allow column.

7. Next, choose the Apply button and then choose the OK button from this dialog box; the
Permissions for Geospatial Coordinate Systems <version> dialog box will be closed and
settings will be saved.

8. Again, choose the OK button in the Geospatial Coordinate Systems <version> Properties
dialog box to close it.

After setting the user access, you can define a coordinate system based on the mapping, modeling,
or project requirements. You can define a new coordinate system by creating a coordinate system
definition, datum, ellipsoid, geodetic transformation, and geodetic transformation path. In
addition to creating a coordinate system, you can create a new coordinate system category. The
method of creating a coordinate system by using the Create a coordinate system definition
option is discussed next.

Creating a Coordinate System by Using the Coordinate System
Definition Option

The Create a coordinate system definition option is used to create a coordinate system by
defining the parameters of the required coordinate system. While creating a coordinate system,
you need to specify various options in different pages of the Create Coordinate System wizard.
To create a coordinate system, choose the Create Coordinate System tool from the Map Setup >
Coordinate System > Create drop-down; the Create Coordinate System wizard will be displayed,
as shown in Figure 3-15. The different pages of this wizard are discussed next.
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Create coordinate system Page
By default, the Create coordinate system page is displayed in the wizard with the Create a
coordinate system definition radio button selected.

|# Create Coordinate System E@

» 1 Create coordinate system Create coordinate system
2 Specify starting point @ Create a coardinate system definition

3 Specity ellipsaid ©) Create a datum

3a. Create ellipsid

Task Overview ([~

() Create an ellipsoid
4. Specify datum © Create a geodetic transformation
Az Creste datum © Create a geodetic transformation path
5. Specify coordinate system () Create & coordinate system category
5a. Create coordinate system

5b. Specify projection

5¢. Specify common parameters

6. Review coordinate system

[ Nec> ][ Cancel |[ Hep

Figure 3-15 The Create coordinate system wizard

To create the coordinate system definition, choose the Next button on this page; the Specify
starting point page of the wizard will be displayed.

Specify starting point Page

In this page, by default, the Start with an ellipsoid radio button is selected. As a result,
you are prompted to create a coordinate system based on ellipsoid. Also, you can select the
Start with a coordinate system or Start with a datum radio button to redefine a coordinate
system or define a coordinate system based on the existing datum. To continue with the
method used for creating a coordinate system, retain the default setting in this page and
then choose the Next button; the Specify ellipsoid page will be displayed.

Specify ellipsoid Page

In this page, you can specify the method of creating an ellipsoid. You can choose to create an
ellipsoid either by defining a new ellipsoid or by modifying the parameters for an existing
ellipsoid.

To create an ellipsoid by modifying the parameters for an existing ellipsoid, select the Create
a new ellipsoid from an existing ellipsoid radio button; the Select button in the Specify
ellipsoid page will be activated.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

3-14 Exploring AutoCAD Map 3D

Choose the Select button; the Coordinate System Library dialog box will be displayed, as
shown in Figure 3-16. Choose the required ellipsoid from the list box in this dialog box and
then choose the Select button; the name of the selected ellipsoid will be displayed in the
Ellipsoid text box. Choose the Next button; the Modify ellipsoid page will be displayed.
This page will display parameters of the selected ellipsoid. You can modify the required
parameters in this page.

# Coordinate System Library EI@
Show
All Projected Geographic Arbitrary Datum Ellipsoid Geodetic Transformation Path Geodetic Transformaticn
Status:| Up to date ¥ | Code type:| Autodesk ¥ | Category: Mo filter selected Unit:| Mo filter selected
Search
Status Code Description Definition type Referenced to Categories EPSG code Unit +
@  arvio Airy, 1830 (=] 7001
&  ARv49 Airy, 1848 (22
@  ARY-MOD Airy, Modified 1849 (=] 7002
@  ARY-WO Airy War Office 2]
@  APL4S AP.L/AS i@
(/] ATS Average Terrestial System 1977,... :‘.:? 7041
Q AUSSIE Awustralian National Spheroid, 1965 é.:? 7003
@  AUSSIESZ Australian (AIG), 1952 (2]
Q BESL-JPN Bessel - 1841, Japan GSI %.;?
[/] BESL-MOD Bessel Modified, NGO Norway :‘.:? 7005
Q BESL-NGO Bessel Modified, NGO Norway %.;?
[/] BESL-NMEB Bessel, Mamibia ;‘.:? 7046
[/] BesINmb-GLM Bessel Namibia (GLM) %.;?
[/] BESL-TRI Bessel Triangulation, RT 90 Sweden ;‘.:?
@  BESSEL Bessel, 1841 =] 7004 - -

Figure 3-16 The Coordinate System Library dialog box

To create an ellipsoid by defining all the ellipsoidal parameters, select the Create a new
ellipsoid radio button from the Specify ellipsoid page of the wizard. Next, choose the
Next button; the Create ellipsoid page will be displayed. The various options in this page
are discussed next.

Create ellipsoid Page
In this page, assign a desired code name to the ellipsoid in the Code edit box. You can also
enter a brief description about the ellipsoid in the Description text box.

The Reference this ellipsoid (rather than a datum) in the coordinate system check box is
cleared by default. As a result, the current ellipsoid will be used for reference in this coordinate
system definition. If you select this check box, the links to the page for specifying datum
will be removed. In the Ellipsoid Dimensions area, you can specify whether you want to
create an ellipsoid or a sphere by selecting the radio button corresponding to the required
option. Depending on the selection of the radio button, the edit boxes for defining the
ellipsoid parameters will be enabled.
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Next, you need to specify values in the Equatorial radius (meters), Inverse flattening,

Polar radius (meters), and Eccentricity squared edit boxes

ellipsoid page with the defined parameters.

. Figure 3-17 shows the Create

Task Overview (A

»

' Create Coordinate System

1. Create coardinate system
2. Specify starting point
3. Specify ellipsoid
3a. Create ellipsoid
4. Specify datum
4a. Create datum
5. Specify coordinate system
5a. Create coordinate system

5Sb. Specify projection

5c. Specify common parameters

6. Review coordinate system

= B |

Create ellipsoid
Code: 8@
WS Ellipsoid
Description:
This is a WGS 84 ellipscid created by defining all parameters,
[ Reference this ellipsoid (rather than a datum) in the coordinate system
Ellipsoid Dimensions
@ Create an ellipsoid Equatorial radius (meters):
() Create a sphere 6378137

Inverse flattening:

0.00335281067183102

Polar radius (meters):

63567523142

Eccentricity squared:

0.0818191909289067

[ <Bace J[ Nex> |[ cancel |[ hep |

Figure 3-17 The Create ellipsoid page displaying the parameters for creating an ellipsoid

After specifying all values in this page, choose the Next button; the Specify datum page of
the Create Coordinate System wizard will be displayed.

Specify datum Page

Similar to the Specify ellipsoid page, you can select the method of creating datum in the
Specify datum page. To create a new datum by defining its parameters, select the Create a
new datum radio button and then choose the Next button in the Specify ellipsoid page;
the Create datum page of the wizard will be displayed.

(7

Note
1o create a datum by modifying parameters of an existing datwm, select the Create a new datum

from an existing datum radio button in the Specify datum page; the Datum edit box and the

Select button will be activated. Next, choose the Select button; the Coordinate System Library
dialog box will be displayed. In this dialog box, choose the requived datum and then choose the
Select button; the Coordinate System Library dialog box will be closed and the selected datum
name will be displayed in the Datum edit box of the Specify datum page. Choose the Next button
in the Specify datum page to proceed.
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Create datum Page

In the Create datum page, you can create a new datum with reference to an existing
ellipsoid. To create a new datum, enter a suitable code in the Code edit box. You can also
add a brief description about the datum in the Description text box. By default, the name
of the ellipsoid specified earlier is displayed in the Ellipsoid edit box. If you want to select
another ellipsoid, choose the Select button; the Coordinate System Library dialog box
will be displayed. Select the required ellipsoid from the list box in the Coordinate System
Library dialog box and then choose the Select button; the dialog box will be closed and the
name of the selected ellipsoid will be displayed in the Ellipsoid edit box. Next, enter the
name of the data source containing the information about selected ellipsoid in the Source
edit box. After specifying all the settings in this page, choose the Next button; the Specify
coordinate system page will be displayed.

Specify coordinate system Page

You can use the options in the Specify coordinate system page to create a new coordinate
system by using your own settings or create a new coordinate system from an existing
coordinate system.

By default, the Create a new coordinate system radio button is selected in the
Specify coordinate system page. Select an option from the Coordinate system type
drop-down list to specify the type of coordinate you wish to create. You can create a Projected,
Geographic, or Arbitrary coordinate system. On specifying all the options in the Specify
coordinate system page, choose the Next button; the Create coordinate system page will
be displayed, as shown in Figure 3-18. Based on the type selected, an icon will be displayed
on upper right corner of this page.

|# Create Coordinate System =N Ech ==
< . =
. 1. Create coordinate system Create coordinate system
H , .
£ 2 spedly starting point Code: PG
O‘>’ 3. Speify ellipsoid
E 3a. Create ellipsoid . )
4. Specify datum escription:
4a. Create datum
5. Specify coordinate system
»  5a. Create coordinate system
5b. Specify projection
Sc. Specify common parameters Source:
6. Review coordinate system
Unit:
Meter - E
Available categories: Categories associated with this coordinate system:
Lat Longs -
Arbitrary X-¥ Coordinate Systems = |
Hiananion
Africa
Albania
Algeria -
Referenced To
@ Geodetic
Datum:
WGS 54 Datum (WGS 84 Datum- using WGS 84-Ellisoid defined by CADCIM)
©) Non-geodetic
Ellipsoid:

WGS84- Ellipsoid (This is 3 WGSE3 elipsaid created by defining all parameters)

[ <Bak | Nex> [ cCancel |[ Hep |

Figure 3-18 The Create Coordinate System wizard with the Create coordinate system page
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Note

If you select the Create a new coordinate system from an existing coordinate system radio
button in the Specify coordinate system page, the Select button will be activated. You can use
this button to select an existing coordinate system.

Create coordinate system Page

In this page, you can specify the settings for a coordinate system based on your project
requirements. To apply a code to the coordinate system to be created, enter a suitable code
in the Code edit box and then enter the desired information in the Description text box.
Next, enter the name of the data source that contains information about current coordinate
system in the Source edit box. To specify a measuring unit for the current coordinate system,
select an option from the Unit drop-down list. To associate the current coordinate system
with an existing category, select the option from the Available categories list box and then
choose the Add button; the selected category will be added to the Categories associated with
this coordinate system list box. To remove a category from this list box, select the unwanted
category and then choose the Remove button; the selected category will be removed.

You need to reference the current coordinate system with a datum or an ellipsoid. By default,
the Geodetic radio button is selected in the Referenced To area of this page. As a result,
the Datum edit box and the Select button on its right are activated. Also, the code of the
datum created in earlier pages is displayed in the Datum edit box. To reference a different
datum, use the Select button.

You can select the Non-geodetic radio button from the Referenced To area to reference an
ellipsoid for the current coordinate system. On selecting this radio button, the Ellipsoid
edit box will be activated and the code of the ellipsoid created earlier will be displayed in
it. You can use the Select button to specify a different ellipsoid. After specifying all settings,
choose the Next button; the Specify projection page of the Create Coordinate System
wizard will be displayed.

Specify projection Page

In this page, you need to specify the settings for the projection parameters. To apply a
projection to the current coordinate system, select an option from the Projection drop-down
list. Depending on the option selected in this drop-down list, a list of parameters will be
displayed in the Specify projection page. For example, on selecting the Albert Equal Area
Conic option in the Projection drop-down list, you need to specify the northern and southern
standard parallel, and the origin latitude and longitude in the Northern standard parallel,
Southern standard parallel, Origin longitude, and Origin latitude edit boxes, respectively.

After specifying all the parameters in this page, choose the Next button; the Specify common
parameters page will be displayed.

Note
The options displayed in the Parameters area will be based on the projection type selected from
the Projection drop-down list.
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Specify common parameters Page

In this page, you can specify the parameters used for projecting given map coordinates.
To apply a scale to the current coordinate system, enter the scale value in the Map (paper)
scale edit box. Next, select the relevant option from the X increases to the and Y increases
to the drop-down lists in the Quadrant area. Next, you need to specify the geographic
limits of the location in terms of latitudes and longitudes. The values entered must be in
the degree format and measured with respect to Greenwich. To specity the range for the
geographic location under study, enter the minimum and maximum values of the latitudes
and longitudes in their respective edit boxes in the Useful Range: Geographic area.

In the Minimum Non-Zero Coordinate Values area, you can specify the geographic

limits of the location under study in terms of Cartesian coordinates. To do so, enter

the non-zero x and y values in the Non-zero X and Non-zero Y edit boxes. To specify the
limits in the form of Cartesian coordinates, choose the button corresponding to the Useful
Range:Cartesian option; four edit boxes will be displayed. Next, enter the limits of the
geographic location in their respective edit boxes. After specifying all parameters in this
page, choose the Next button; the Review coordinate system page will be displayed.

Review coordinate system Page

In this page, you can review the values, parameters, and settings applied to the current
coordinate system. To modify any setting, choose the Edit button in the area corresponding
to the option to be modified. On doing so, the page corresponding to the options to be
modified will be displayed. In the page displayed, modify the settings of parameters based
on project requirement and then choose the Review coordinate system link from the Task
Overview; the Coordinate System page will be displayed with the modified settings. After
reviewing all the parameters in this page, choose the Finish button; the Create Coordinate
System dialog box will be closed and a coordinate system will be created in the specified

category.

Assigning a Coordinate Reference System to Data

Ribbon: Map Setup > Coordinate System > Assign
Command: MAPCSASSIGN

As mentioned earlier, the coordinate reference system defines how an object spatially relates
to a location on the Earth’s surface. A spatial data with a defined CRS can be easily integrated
into your project and can be used for the purpose of spatial analysis.

You can start a new project by defining its coordinate reference system and then create datasets.
The procedure to define coordinate reference system to a dataset while importing it into your
drawing environment and the procedure to assign coordinate reference system to your drawing
(project) is discussed next.

Assigning CRS to the Drawing
You can use the Assign tool to define a coordinate system to the current drawing. To
@ assign a CRS to the drawing, choose the Assign tool from the Coordinate System panel;
Assign  the Coordinate System - Assign dialog box will be displayed, as shown in Figure 3-19.
The options in different areas of the dialog box are discussed next.
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9 AdindanUTM-... Adindan / UTM zone 38N @ Ethiopia;Sudan;Africa 20138 Meter
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Figure 3-19 The Coordinate System - Assign dialog box

Currently Assigned Area

The Code and Description in this area display code and description of the coordinate system
(CRS) that has been currently assigned to the drawing. In case no CRS has been defined,
the Code and Description labels will display N/A.

Show Area

The Show area of the Coordinate System - Assign dialog box contains four drop-down lists,
namely Status, Code type, Category, and Unit. You can use the options in these drop-down
lists to filter the list of available coordinate system. These drop-down lists are discussed nexct.

Status: You can filter the coordinate system (CRS) based on the status by selecting the
relevant option from the Status drop-down list in the Show area. To view the list of updated
coordinate systems, select the Up to date option from the Status drop-down list. Similarly,
to view the list of out of date coordinate systems, select the Out of date option from the
drop-down list. You can also select the User defined option from the drop-down list to view
the coordinate system created by the user.

Code: To filter the coordinate systems based on the code, select the relevant option from the
Code type drop-down list. To filter the coordinate systems based on the EPSG (European
Petroleum Survey Group) code, select the EPSG option from the drop-down list else select
the Autodesk option from the drop-down list.
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Category: This drop-down list contains the list of available categories of coordinate systems.
To filter the coordinate systems based on the category, select the required option from this
drop-down list. For example, to display the list of geographic coordinate system, select the
Lat Longs option from the drop-down list. Similarly, you can select the country name to
filter the coordinate systems based on the country. For example, to view the list of coordinate
systems for Australia, select the Australia option from the Category drop-down list. The
coordinate system can also be filtered based on the arbitrary coordinate system, obsolete
coordinate system, UTM coordinate system, and so on.

Unit: To view the list of coordinate system based on a particular unit, select the required
option from the Unit drop-down list. For example, to view the list of coordinate systems
based on the US Survey foot, select the US Survey foot option from the drop-down list.
Similarly, you can view the list of coordinate systems based on meters, international foot,
degrees, and so on.

Search Area

You can use the edit box in the Search area to search the required coordinate system from the
coordinate system library. To find a coordinate system, enter the code, description, details,
or information of the coordinate system in this edit box. The list of coordinate systems
displayed below the search edit box will dynamically update as you type in the search edit box.

After applying filters, select the required coordinate system from the list displayed below the
search text box. To read the details about the selected coordinate system, choose the View
button; the Coordinate System window will be displayed, refer to Figure 3-20. Choose the
Close button in this window to exit. Next, to assign the selected coordinate system to the
drawing, choose the Assign button from the Coordinate System - Assign dialog box; the
dialog box will be closed and the coordinate system will be assigned to the current drawing.

Coordinate System - UTM84-43N =
y:
| (S T s | Coordinate System

-Projection Code: @o
UTMB84-43N

-Parameters
Description:

SWKT UTM-WGS 1984 datum, Zone 43 Morth, Meter; Cent. Meridian 75d E

Datum
Ellipsoid EPSG code:

32643
Oracle SRID:
32642
Source:
Snyder, 1P, 1987, Map Projections - A Working Manual
Unit:
Meter
Categories:
UTM, WG584 Datum
Referenced To
Daturn:
WGS84 (World Geodetic System of 1984)

Figure 3-20 Partial view of the Coordinate System window with the Coordinate System page
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Using the Connect Tool to Assign a Coordinate System to a
Dataset

A coordinate system can be assigned to a dataset using the Connect
tool and also to load the data into the Workspace. To do so, select
data in an external data format by using the Connect tool as explained in the previous chapter,
and then choose the Edit Coordinate Systems button located at the top of the list box; the Edit
Spatial Contexts dialog box will be displayed, as shown in Figure 3-21.

@ Edit Coordinate Systems

| Edit Spatial Contexts (=5
Spatial Contexts:
Name Coordinate System Overmide
Default < unknown >

Cancel

Figure 3-21 The Edit Spatial Contexts dialog box

To assign a new coordinate system or edit an existing coordinate system, double-click on the
first record in the Spatial Contexts list box; the Coordinate System Library dialog box will be
displayed. Alternatively, to invoke the Coordinate System Library dialog box, select the record
in the Spatial Contexts list box and then choose the Edit button; the Coordinate System Library
dialog box will be displayed. Select the required coordinate system from the Coordinate System
Library dialog box and then choose the Select button; the dialog box will be closed and the code
of the selected coordinate system will be displayed in the Override column of the Edit Spatial
Contexts dialog box, refer to Figure 3-22. Next, choose the OK button; the dialog box will be
closed and the selected coordinate system will be assigned to the dataset.

| Edit Spatial Contexts (===
Spatial Contexts:
Mame Coordinate System COvemide Edit...

)
o] &b
IE

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

Cancel

Figure 3-22 The Code of the selected coordinate system displayed in the Override column

Q‘ Tip: You can also invoke the Edit Spatial Contexts dialog box by choosing the Edit
Coordinate System option from the shortcut menu. 1o display the shortcut menu, right-click
on the dataset name in the DATA CONNECT wizard.
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USER COORDINATE SYSTEMS IN AutoCAD

AutoCAD Map 3D application is developed using an AutoCAD platform. In AutoCAD, there
are two coordinate systems: World Coordinate System (WCS) and User Coordinate System
(UCS). These coordinate systems are also available in AutoCAD Map 3D. Whenever you start
the AutoCAD Map 3D application, the drawing will be set to WCS. WCS is a fixed coordinate
system and the X axis in WCS is the horizontal axis, the Y axis is vertical and the Z axis is
perpendicular to the XY plane. The origin is defined at the intersection of X and Y axis (0, 0)
in the lower left corner of the drawing. Using WCS, you can create 2D drawings and surface
models. However, creating 3D models with multiple features using WCS is a cumbersome task.
In such a scenario, a custom defined coordinate system may help accelerate the drafting process.
A custom defined coordinate system is called as the User Coordinate System (UCS). You can
define a UCS in terms of the WCS. While defining the UCS, you can specify its origin and the
orientation of its axis. This helps you to specify points in three-dimensions. A brief description
of working with UCS is given next.

Moving the UCS Triad

Ribbon: View > Coordinates > UCS
Command: UCS

IL. To move the UCS triad, choose the UCS tool from the Coordinates panel of the View tab;

the cursor changes into crosshair in the drawing window. Place the crosshair at the required
point and then click; the UCS triad moves to the specified point. Next, press ENTER; the
position of the UCS triad will be fixed at the specified point.

Rotating the UCS Triad about the X Axis

Ribbon: View > Coordinates > X
Command: UCS

1% You can rotate the UCS about the X axis in the

YZ plane. To rotate the UCS icon in the YZ i
plane while keeping the X axis fixed, choose the X ;
tool from the Coordinates panel; the cursor will R
change to a crosshair in the drawing window and
you will be prompted to specify the rotation angle. } X
Enter the rotation angle and press ENTER; the UCS
will rotate about the X axis. The angle of rotation

can be applied to the UCS icon, as shown in Figure Figure 3 -23 Rotating the UCS icon keeping
3-23. the X axis fixed

User-defined
angle of
... rotation

Similarly, you can use the Y and Z tools from the Coordinates panel of the View tab to IE
rotate the UCS icon in the XZ and XY plane, respectively.

3

z
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Using a Named UCS for Drawings
Ribbon: View > Coordinates > Named

You can assign a name to the UCS and then use it anytime during the project. The UCS 1=
settings that need to be applied to many drawing objects in the project can be saved as a
template so that you can use the new template for many drawing objects as per project
requirement. In the previous section of this chapter, you learned how to realign a UCS as per
your requirement. To specify a named UCS for drawings in the project, choose the UCS, UCS
Settings button from the Coordinates panel; the UCS dialog box will be displayed, as shown
in Figure 3-24. The Named UCSs, Orthographic UCSs, and Settings tabs in the UCS dialog
box are discussed next.

i ucs B

Mamed UCSs |Orlhoglaphic UCSs ISeﬂingsl

Cument UCS: Unnamed

P[L, Unnamed Set Cument
= Previus

[ ok || cancel | [ Hep

Figure 3-24 The UCS dialog box

Named UCSs Tab

The options in the Named UCSs tab are used to specify a name for the modified UCS E
settings and to set a named UCS as the current UCS. In the UCS dialog box, choose the
Named UCSs tab, if it is not chosen by default. To rename a UCS, select it from the Current UCS
list box and then right-click on the Unnamed option; a shortcut menu will be displayed. Choose
the Rename option from this shortcut menu; the Unnamed option will change into an edit box.
In this edit box, enter a name, and then press ENTER. To set a particular UCS as the current
UCS, select it from the Current UCS list box and right-click; a shortcut menu will be displayed.
Choose the Set Current option from the shortcut menu and the selected UCS will be set as the
current UCS. Alternatively, to set the UCS as the current UCS, select the relevant UCS and then
choose the Set Current button; the selected UCS will be set as the current UCS. To delete a
particular UCS, choose the Delete option from the shortcut menu. You can also choose the
Details option from the shortcut menu to view the details of the selected UCS.

Note
The Unnamed option will appear only if you have modified the alignment of the default UCS icon.
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Orthographic UCSs Tab

The options in the Orthographic UCSs tab of the UCS dialog box are used to apply the
orthographic coordinate system to the current drawing with reference to the available coordinate
system. To apply a particular orthographic coordinate system to the current drawing, choose an
option from the Name list box in the UCS dialog box. To apply the orthographic coordinate
system with reference to an available coordinate system, choose an option from the Relative to
drop-down list. To apply the modified settings to a coordinate system, choose the Set Current
button. Next, choose the OK button; the UCS triad will change to the settings specified in the
drawing window.

Settings Tab

The options in the Settings tab are used to specify the displaying and aligning properties of the
UCS triad. These settings are discussed next.

UCS Icon settings Area

The options in the UCS Icon settings area are used to set the properties of the UCS icon.
To hide the UCS icon from the drawing window, clear the On check box. To display the
UCS icon at the lower left corner of the drawing window instead of displaying it at the origin
of the coordinate system, clear the Display at UCS origin point check box. To apply the
modified UCS settings to all viewports in the current drawing, select the Apply to all active
viewports check box. To enable the selection of the UCS icon, select the Allow Selecting
UCS icon check box. Note that, by default, this check box is selected.

UCS settings Area

The options in the UCS settings area are used to set viewports with UCS. The Save UCS
with viewport check box is selected by default in this area. As a result, the modified UCS
settings will be saved with the current viewport. If you clear the Save UCS with viewport
check box, the modified settings will be applied to the entire drawing. To apply the current
UCS settings to the viewport and ignore the UCS settings applied to a particular viewport,
clear the Save UCS with viewport check box. To restore the plan view when the coordinate
system in the viewport is changed, select the Update view to Plan when UCS is changed
check box. Next, choose the OK button to close the dialog box.

TUTORIALS

General instructions for downloading tutorial files:
To complete the tutorials, you need to download the tutorial data to your computer. To download
the tutorial data, follow the steps given below:

1. Log on to www.cadcim.com and browse to Textbooks > Civil/GIS > Map 3D > Exploring AutoCAD
Map 3D 2016. In this page, select c03_m3d_2016_tut.zip file from the Tutorial Files drop-down
list. Next, choose the corresponding Download button to download the data file.

2. Extract the contents of the zip file to the following location:

C:\m3d_2016
Notice that the ¢c03_m3d_2016_tut folder is created in the m3d_2016 folder.
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Tutorial 1 Assigning CRS

In this tutorial, you will start with a new drawing file. Next, you will assign a Coordinate
Reference System (CRS) to the current drawing. (Expected time: 30 min)

The following steps are required to complete this tutorial:

a. Start a new drawing file.

b. Assign the NE83 - NAD83 Nebraska State Planes, Meter coordinate system to the current
Workspace.

c.  Save the file.

Starting a New Drawing
1. Choose New > Drawing from the Application Menu; the Select template dialog box is
displayed.

2. In the Select template dialog box, select the map2d.dwt template file and then choose the
Open button; the map2d template is applied to the Modelspace.

Assigning a Global Coordinate System to the Current Workspace

1. Choose the Assign tool from the Coordinate System panel in the Map Setup tab; @
the Coordinate System - Assign dialog box is displayed. sevon

2. In the Show area of the dialog box, select the USA, Nebraska option from the Category
drop-down list; a list of coordinate systems in this category is displayed in the list box of the
dialog box.

3. Next, select the NE83 code with description NAD83 Nebraska State Planes, Meter from
the list box, and then choose the Assign button; the selected coordinate system is assigned
to the Workspace.

Savmg the Drawing File
Choose the Save As option in the Application Menu; the Save Drawing As dialog box is
displayed.

2. In the Save Drawing As dialog box, enter c03_Tut0la in the File name edit box and
make sure that the AutoCAD 2013 Drawing (*.dwg) option is selected in the Files of type
drop-down list.

3. Next, choose the Save button; the drawing file is saved at the specified location.

Tutorial 2 Creating a Coordinate Reference System

In this tutorial, you will create a Coordinate Reference System using the parameters given below and
then assign it to the current drawing. (Expected time: 45 min)
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Parameters of ellipsoid:
Code: CADCIM-GRS1980
Equatorial radius = 6378137 m
Polar radius = 6356752.31414035 m
Inverse flattening= 0.00335281068118332
Eccentricity squared= 0.0818191910428279

Parameters of datum:
Code: CADCIM- NADS83
Source: CADCIM

Parameters of new coordinate system:
Coordinate system type: Projected
Code: Austin TX
Source: CADCIM
Unit: US Survey Foot
Category: test only
Referenced to: (Geodetic) CADCIM- NAD83 datum

Projection: Lambert Conformal Conic, double standard parallel

Northern standard parallel: 31.8833333333333
Southern standard parallel: 30.1166666666667
Origin longitude: -100.333333333333

Origin latitude: 29.6666666666667

False easting: 2296583.33333333

False northing: 9842500

Common Parameters:
Map scale: 1
X Increases to the: East,
Y Increases to the: North
Minimum longitude: -108.3
Maximum longitude: -91.8666666666667
Minimum latitude: 29.5333333333333
Maximum latitude: 32.5
Non zero X:
Non zero Y: 0

The following steps are required to complete this tutorial:

Verify folder permissions.
Start a new drawing file.

Create a coordinate system definition using the given parameters.

Assign the coordinate system to the current drawing.
Save the file.
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Verifying Folder Permissions

AutoCAD Map 3D saves the created CRS in the Geospatial Coordinate Systems folder. As a
result, you need to have write permission to this folder. In this part of tutorial, you will verify
the permissions for this folder and change them if necessary.

1. Close the AutoCAD Map 3D 2016 software application, if it is running.
2. In the Windows Explorer, browse to the following location:

C:\ProgramData\Autodesk

Note
@ The ProgramData folder is a hidden folder. To view this folder, you need to turn on the Show
hidden files, folders and drives option for your Windows operating system.

3. Inthe Autodesk folder, right-click on the Geospatial Coordinate Systems <version> folder;
a shortcut menu is displayed. In this menu, choose the Properties option; the Geospatial
Coordinate Systems <version> Properties dialog box is displayed.

4. In this dialog box, choose the Security tab from this dialog box; the options in this tab are
displayed. Choose the Edit button in this tab; the Permissions for Geospatial Coordinate
Systems <version> dialog box is displayed.

5. Inthis dialog box, select a user name from the Group or user names list box; the permissions
assigned to the selected user are displayed in the Permissions for Users list box.

6. In the Permissions for users list box, select the check box corresponding to the Full Control
option in the Allow column; all the check boxes in the Allow button are selected by default.

7. Next, choose the Apply and then the OK button from this dialog box; the Permissions for
Geospatial Coordinate Systems <version> dialog box is closed and the settings are saved.

8. Again, choose the OK button in the Geospatial Coordinate Systems Properties <version>
dialog box to close it.

Starting the AutoCAD Map 3D Application
1. Start the AutoCAD Map 3D 2016 application.

Creating a Coordinate System Definition Using the Given Parameters

In this part of the tutorial, you will define the coordinate system using the Create Coordinate
System tool. You will first define an ellipsoid and datum. Next, using the defined ellipsoid, datum,
and the parameters given in the tutorial data, you will create the coordinate reference system.

1. Choose the Create Coordinate System tool from Map Setup > Coordinate System > Create
drop-down; the Create Coordinate System wizard with the Create coordinate system page
is displayed.
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In this page, select the Create a coordinate system definition radio button, if it is not
selected by default. Next, choose the Next button; the Specifying starting point page of
the wizard is displayed.

In this page, select the Start with an ellipsoid radio button, if it is not selected by default.
Next, choose the Next button; the Specify ellipsoid page is displayed.

In this page, select the Create a new ellipsoid radio button, if it is not selected by default
and then choose the Next button; the Create ellipsoid page is displayed.

In the Create ellipsoid page, enter CADCIM-GRS1980 in the Code edit box.
Next, enter Based on Geodetic Reference System of 1980 in the Description text box.

Make sure that the Reference this ellipsoid (rather than a datum) in the coordinate system
check box is cleared and the Create an ellipsoid radio button is selected in the Ellipsoid
Dimensions area.

Enter 6378137 as the equatorial radius, 0.00335281068118332 as the inverse flattening
ratio and 6356752.31414035 as the polar radius in the Equatorial radius (meters), Inverse
flattening, and Polar radius (meters) edit boxes, respectively. Notice that the value for the
eccentricity squared parameter is calculated and displayed automatically in the Eccentricity
squared edit box, refer to Figure 3-25.

|# Create Coordinate System ===
< . .
1. Create coordinate system Create ellipsoid
z
z ) -
H 2. Specify starting point Code: a6
- 2. Specify ellipsaid
6| I PEUTEOR CADCIM-GRS1980
E ¥ 3a.Create ellipsoid

4. Specify datum Description:

4a. Create datum Based on Geodetic Reference System of 1980

5. Specify coordinate system
5a. Create coordinate system
5h. Specify projection [] Reference this ellipsoid (rather than & datum) in the coordinate system
Sc. Specify common parameters Ellipsaid Dimensions

6. Review coardinate system @ Create an ellipscid Equatorial radius (meters):

@ Create a sphere 6378137

Inverse flattening:
0.00335281068118332
Polar radius (meters):

635675231414035

Eccentricity squared:

0.0818191910428279

Figure 3-25 Partial view of the Create ellipsoid page of the Create Coordinate System wizard

9. Choose the Next button; the Specify datum page of the wizard is displayed.

10. Make sure that the Create a new datum radio button is selected in this page and then choose

the Next button; the Create datum page is displayed.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

Notice that the ellipsoid defined earlier as CADCIM-GRS1980 is selected and displayed as
CADCIM-GRS1980 (Based on Geodetic Reference System of 1980) in the Ellipsoid text
box of the create datum page.

Next, enter CADCIM- NADS83 in the Code edit box and NAD 1983 Datum- Ellipsoid
GRS1980 in the Description text box.

Next, enter CADCIM in the Source edit box.

Choose the Next button in the Create datum page; the Specify coordinate system page of
the wizard is displayed.

In this page, select the Create a new coordinate system radio button if it is not selected by
default.

Select the Projected option from the Coordinate system type drop-down list, if it is not
selected by default, and then choose the Next button; the Create coordinate system page
is displayed in the wizard.

In this page, enter Austin TX in the Code edit box and User defined CRS-Austin city in
the Description text box.

Enter CADCIM in the Source edit box.
Ensure the US Survey Foot option is selected in the Unit drop-down list.

Choose the Test Only option from the Available categories list box and then choose the
Add button; the selected category is added to the Categories associated with this coordinate
system list box.

Make sure that the Geodetic radio button is selected in the Referenced To area of this
page and the Datum text box displays CADCIM- NAD83 (NAD 1983 Datum- Ellipsoid
GRS1980), refer to Figure 3-26.

Choose the Next button in the Create coordinate system page; the Specify projection page
of the wizard is displayed.

In this page, you will specify the projection parameters for the coordinate reference system.

In this page, select the Lambert Conformal Conic, double standard parallel option from
the Projection drop-down list; the Create Coordinate System - Projection message box is
displayed. Choose the Yes button in this message box to close it.

In the Parameters area of the Specify projection page, specity 31.8833333333333 and
30.1166666666667 in Northern standard parallel and Southern standard parallel edit
boxes, respectively.

Next, in the Projection Origin area, specify -100.333333333333 and 29.6666666666667
in the Origin longitude and Origin latitude text boxes, respectively.
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A Create Coordinate System

< L. Create coordinate system Create coordinate system -
§ 2. Specify starting point Code:

g 3. Specify ellipsoid Austin TX

2

3a. Create ellipsoid Cescription:

4. Specify dat

4 Specify datum User defined CRS-Austin city
43, Creste datum

5. Specify coordinate system

} Sa. Create coordinate system

5b. Specify projection
5
. Review coordinate system CADCIM

cify common parameters Source:

Unit:

m

US Survey Foot -]

Available categories: Categories associated with this col

Test Only

Syria -
Tadzhikstan

Tabwan
Tanzania =

Teworly

Thailand -

Referenced To
@ Geodetic
Datum:

‘CADCIM- NADS3 (NAD 1983 Datum- Ellipsoid GRS1%80)

© Non-geodetic
Ellipsoid:
CADCIM-GRS1980 (Based on Geodetic Reference System of 1980) -

! n ] 0

[ <Back |[ Next> ][ cancel |[ hep |

Figure 3-26 The Create coordinate system page displaying various parameters for creating CRS

25. Specify 2296583.33333333 and 9842500 in the False easting and False northing text boxes,
respectively. Figure 3-27 shows the Specify projection page of the wizard with the projection
parameters.

| Create Coordinate System

3a. Create ellipsoid

<) . . .
S| LCreate coordinate system Specify projection
H
H 2. Specify starting point Projection:
3.5 llipsoid
é 3. Spectly ellipsoid [Lambert Conformal Conic, double standard parallel -
]
Kl

4, Specify datum "
Northern standard parallel: Southern standard parallel:

30.1166666666667

4a. Create datum

5. Specify coordinate system 31.8833333333333

5a. Create coordinate system Projection Origin

5b. Specify projection All latitude and longitude parameters must be specified in degrees. Al longitude parameters are relative to Greenwich.
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26. Choose the Next button in the wizard; the Specify common parameters page is displayed.

5c. Specify common parameters

6. Review coordinate s

Origin longitude:

-100. 33333333333ﬂ

False Origin
False easting:

2206583.33233333

Origin latituds:
20.6666666666667

False northing:

9842300

Figure 3-27 Partial view of the Specify projection page

27. In the Scaling area, specify 1 in the Map (Paper) scale edit box.
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28.

29.

30.

31.

32.

33.

Next, select the East and North options in the X increases to the and Y increases to the
drop-down lists, respectively.

In the Useful Range: Geographic area, enter -108.3 and -91.8666666666667 in the
Minimum longitude and Maximum longitude edit boxes, respectively.

Specify 29.5333333333333 and 32.5 as the minimum and maximum latitude values in the
Minimum latitude and Maximum latitude edit boxes, respectively.

Retain 0 in both the Non-zero X and Non-zero Y edit boxes.

Choose the Next button in the Specify common parameters page; the Coordinate System
page with the summary of the coordinate system, is displayed.

Choose the Finish button; the Create Coordinate System wizard is closed and the coordinate
system is saved in the Geospatial Coordinate Systems folder.

Assigning the Created Coordinate System to the Current Drawing

1.

Choose the Assign tool from the Coordinate System panel in the Map Setup tab; @
the Coordinate System-Assign dialog box is displayed. o

ssign
In the dialog box, select the User defined option from the Status drop-down list in the
Show area; the list of user-defined coordinate systems is displayed in the list box below the
Search area.

Select the Austin TX code from the displayed list and then choose the Assign button; the
dialog box is closed and the selected coordinate system is assigned to the current drawing.

Saving the Drawing File

1.

Choose the Save As option in the Application Menu; the Save Drawing As dialog box is
displayed.

In the Save Drawing As dialog box, enter c03_Tut02a in the File name edit box and select
the AutoCAD 2013 Drawing (*.dwg) option in the Files of type drop-down list, if it is not
selected by default. Now, choose the Save button next to the File name edit box; the current
drawing file is saved with the given name.

Tutorial 3 Assigning CRS while Loading Data

In this tutorial, you will assign a coordinate system (CRS) to a dataset while loading it using the
Connect tool. (Expected time: 20 min)

The following steps are required to complete this tutorial:

a.

b.

Start a new drawing file and then assign the IslandsNET1993.LL ISN93 coordinate system
to the dataset while loading data by using the Connect tool.
Save the file.
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Starting a Drawing File

1.

Choose New > Drawing from the Application Menu; the Select template dialog box is
displayed.

In the Select template dialog box, select the map2d.dwt template file and then choose the
Open button; the map2d template is applied to the Modelspace.

Assigning the Coordinate System to the Dataset Using the Data Connect
Tool

1.

10.

11.

Choose the Connect tool from the Data panel in the Home tab; the DATA CONNECT
wizard is displayed.

In the DATA CONNECT wizard, select the Add SHP Connection option from the Data
Connections by Provider list box; the OSGeo FDO Provider for SHP page is displayed in
the right pane of the wizard.

In the OSGeo FDO Provider for SHP page, choose the browse button next to the
Source file or folder edit box; the Open dialog box is displayed. In this dialog box,
browse to the following location: C:\m3d_2016\c03_m3d_2016\c03_tut03.

Next, select the c03-m3d-2016-tut03.shp file from the list box and then choose the Open
button; the Open dialog box is closed and the path of the shape file is added to the Source
file or folder edit box in the OSGeo FDO Provider for SHP page.

Choose the Connect button; the selected shape file is displayed in the Add Data to Map list
box.

Choose the Edit Coordinate Systems button in the Add Data to Map area; the Edit Spatial
Contexts dialog box is displayed.

In the Edit Spatial Contexts dialog box, select the first row and then choose the Edit button;
the Coordinate System Library dialog box is displayed.

In the Coordinate System Library dialog box, select the Iceland option from the Category
drop-down list; a list of coordinate systems in the selected category is displayed in the list
box below the Search edit box.

Next, select the IslandsNET1993.LL code with the ISN93 description option from the list
box.

Choose the Select button in the Coordinate System Library dialog box; this dialog box is
closed and the IslandsNet1993.LL code is displayed in the Override column of the Edit
Spatial Contexts dialog box.

Choose the OK button in the Edit Spatial Contexts dialog box; the dialog box closes and
the selected coordinate system is assigned to the shape file.
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12.

13.

In the DATA CONNECT wizard, choose the Add to Map button; the shape file is connected
to the Workspace. Note that the Display Manager tab of the TASK PANE displays the name
of the added feature class.

Close the DATA CONNECT wizard by choosing the Close [X] button from the upper left

corner; this wizard is closed and the geometry of the shape file is displayed in the drawing
window, refer to Figure 3-28.

Figure 3-28 Model created by combining various features

Saving the Drawing File

1.

Choose the Save As option in the Application Menu; the Save Drawing As dialog box is
displayed.

In the Save Drawing As dialog box, enter c03-m3d-2016-tut03a in the File name edit box
and select the AutoCAD 2013 Drawing (*.dwg) option in the Files of type drop-down list.
Now, choose the Save button next to the File name edit box; the current drawing file is
saved with the given name.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1.

2.

3.

Which of the following zoom options displays the previous zoom state of the drawing?

(a) Window (b) Realtime
(c) Previous (d) Object

Which of the following tools is used to specify a coordinate system for the dataset?

(a) Connect (b) Create
(c) Assign (d) Export

Which of the following shortcut keys is used to toggle the display of the grid in the drawing
window?

(a) F7 (b) F8
(c) F10 (d) F6

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

3-34 Exploring AutoCAD Map 3D

10.

11.

12.

13.

14.

15.

Which of the following tabs in the Drafting Settings dialog box is used to specify the settings
for the snap grid?

(a) Polar Tracking (b) Object Snap
(c) Dynamic Input (d) Snap and Grid

Which of the following functional keys are used to turn on the Object Snap in the drawing
window?

(a) F11 (b) F9

(c) F3 (d) ¥7
You can use the object snap option to track the end point of a line segment.
The option in the Navigate panel of the View tab is used to zoom to the limits

of the selected layer in the drawing window.

The object snap option is used to snap to the center of an arc, circle, ellipse, or
elliptical arc.

To view the list of coordinate systems that are created by the user, select the
option from the Status drop-down list of the Coordinate System dialog box.
The world coordinate system is a coordinate system that cannot be modified.

Asyou increase the scale value in the AutoCAD Map 3D Scale option, the view of the drawing
gets enlarged. (T/F)

When you work in the Ortho mode, you can draw lines along any direction. (T/F)
You can define a new global coordinate system as per your requirement. (1/F)
You cannot align the User Coordinate System (UCS) about any other direction. (1/F)

You cannot assign a coordinate system to a data from an external source. (1/F)

Review Questions

Answer the following questions:

1.

The tool in the Coordinates panel of the View tab is used to rotate the UCS
icon in the YZ plane.
The Midpoint object snap mode is used to track the point of a line segment.

The projected coordinate systems are derived from the
using the map projections.

coordinate systems by
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4. The angle between the prime meridian and the meridian plane of any point on earth’s
surface is known as

5. You can invoke the Edit Spatial Contexts dialog box by choosing the button in
the DATA CONNECT wizard.

6. Longitude is the angle from the equatorial plane to the perpendicular to the ellipsoid
through a given point. (1/F)

7. The grid spacing and snapping cannot be adjusted as per the user requirement. (T/F)
8. You can create a user-defined coordinate system using an existing coordinate system. (1/F)

9. By specifying projection parameters, you can transform a coordinate system from one system
to another system. (1/F)

10. Map projections always results in Cartesian Coordinate System. (1/F)

Exercise 1

Create a geographic coordinate system using the parameters given below and then assign it to
the current drawing. (Expected time: 40 min)

Units: degree

Minimum Longitude -180 Maximum longitude 180
Minimum Latitude -90 Minimum Latitude 90
Ellipsoid (WGS 84)

Code- UserDefinedWGS84 Equatorial radius: 6378137
Polar radius: 6356752.3142 Inverse Flattening: 0.00335281067183102
Eccentricity: 0.0818191909289067

Hint:
This coordinate reference system is based on LL84.
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Answers to Self-Evaluation Test
l.c, 2. ¢ 3. a,4.d, 5. ¢, 6. Endpoint, 7. Extents, 8. Center, 9. User defined, 10. fixed, 11. T,
12.F, 13.7T, 14. F, 15. F



